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Работа с текстом. 
Команды ввода.

■ В AutoCAD имеются специальные 
инструменты для ввода и редактирования 
текста. 

■ Программа позволяет импортировать 
данные из текстовых редакторов, а также 
использовать специальные символы.



Команды для ввода текста

DTEXT (Однострочный 
текст)

■ Команда 
применяется, если 
необходимо добавить 
на чертеж текст, 
который может 
уместиться в одной 
строке, например 
небольшое 
примечание. 

MTEXT (Многострочный 
текст)
■ Команда 

используется в тех 
случаях, когда 
нужно добавить 
расширенное 
описание или любой 
другой достаточно 
большой текстовый 
фрагмент. 

3



Ввод текста 
■ Введите в командную строку команду DTEXT 

(Однострочный текст) для создания 
однострочного текста или MTEXT 
(Многострочный текст) для создания 
многострочного текста. 

■ Выберите в меню Draw Text Single Line Text 
(Рисование Текст Однострочный текст) для 
создания однострочного текста или Draw Text 
Multiline Text (Рисование Текст Многострочный 
текст) для создания многострочного текста. 
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Ввод текста 
■ Нажмите кнопку Multiline Text (Многострочный 

текст) на панели 2D Draw (Двухмерное 
рисование) пульта управления для создания 
многострочного текста. 

■ Нажмите кнопку Single Line Text (Однострочный 
текст) для создания однострочного текста или 
Multiline Text (Многострочный текст) для 
создания многострочного текста на панели 
инструментов Text (Текст) либо на панели Text 
(Текст) пульта инструментов. 
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■ Для создания текста можно использовать 
как отдельную панель инструментов Text 
(Текст), так и одноименную панель пульта 
инструментов, однако содержащиеся на 
них инструменты несколько различаются. 
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■ Для ввода текста используются шрифты с 
расширением SHX, которые входят в 
поставку AutoCAD и устанавливаются 
вместе с программой. 
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Специальные символы

■ Ctrl+Shift+Пробел — неразрывный 
пробел; 

■ %%d — символ градуса °; 
■ %%c — символ диаметра Ø; 
■ %%p — символ ±; 
■ \u+2248 — почти равно 
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Специальные символы

■ \u+2220 — угол Z; 
■ \u+e100 — знак границы; 
■ \u+2104 — знак осевой линии; 
■ \u+0394 — дельта Δ; 
■ \u+0278 — электрическая фаза; 
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Специальные символы

■ \u+e101 — линия потока жидкости; 
■ \u+2261 — знак идентичности ; 
■ \u+e200 — знак исходной длины; 
■ \u+e102 — знак линии основания; 
■ \u+2260 — не равно ; 
■ \u+2126 — знак Ома Ω; 
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Специальные символы

■ \u+03a9 — Омега Ω; 
■ \u+214a — линия свойств; 
■ \u+2082 — нижний индекс с цифрой 2; 
■ \u+00b2 — верхний индекс с цифрой 2; 
■ \u+00b3— знак возведения в куб. 
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Однострочный текст

■ После ввода команды DTEXT 
(Однострочный текст) программа выдает 
запрос: 

Current text style:  "Standard"  Text height:  2.5000 Specify 
start point of text or [Justify/Style]: 

(Текущий текстовый стиль: "Стандартный" Высота 
текста: 2.5000 

Укажите начальную точку текста или 
[Выравнивание/Стиль]:)
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■ Если вас устраивают настройки по 
умолчанию, то укажите точку, в которой 
будет начинаться текстовый объект. После 
этого появится запрос:
Specify height <2.5000>: (Укажите высоту <2.5000>:) 

Укажите высоту текста. 

■ Если вас устраивает высота, 
установленная по умолчанию, нажмите 
клавишу Enter . 
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■ Следующий запрос будет таким: 
Specify rotation angle of text <0>: (Укажите угол 

поворота текста <0>:) 

■ Задайте угол поворота текста или 
оставьте настройки по умолчанию, нажав 
клавишу Enter . 
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■ Если необходимо задать дополнительные 
параметры выравнивания, то после запроса

Current text style:  "Standard"  Text height:  2.5000 
Specify start point of text or [Justify/Style]: 

(Текущий текстовый стиль: "Стандартный" Высота 
текста: 2.5000 

Укажите начальную точку текста или 
[Выравнивание/Стиль]:) 

■ необходимо ввести букву J. 
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■ Программа выдаст следующий 
запрос: 

Enter an option 
[Align/Fit/Center/Middle/Right/TL/TC/TR/

ML/MC/ MR/BL/BC/BR]: 
(Введите параметр [Вписанный/По 

ширине/Центр/Середина/Вправо/ВЛ/ВЦ
/ ВП/СЛ/СЦ/СП/НЛ/НЦ/НП]:) 

■ Все эти параметры также доступны 
посредством динамического ввода. 
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Назначение параметров 
для выравнивания текста 

■ Align (Вписанный). В этом случае следует 
указать начало и конец воображаемой 
горизонтальной линии, на которой 
располагается текст. Чем больше символов 
будет в тексте, тем меньше будет их высота. 

■ Fit (По ширине). При выборе данного параметра 
следует указать начало и конец воображаемой 
горизонтальной линии, на которой 
располагается текст. Чем больше символов 
будет в тексте, тем меньшей будет их ширина. 

17



Назначение параметров 
для выравнивания текста 
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Назначение параметров 
для выравнивания текста 

■ Center (Центр). При выборе этого параметра 
следует указать центральную точку объекта. 
Текст будет центрироваться относительно 
этой точки по горизонтали. 

■ Middle (Середина). При выборе данного 
параметра следует указать центральную 
точку объекта. Текст будет центрироваться 
относительно этой точки по горизонтали и 
вертикали. 
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Назначение параметров 
для выравнивания текста 

■ Right (Вправо). При выборе этого 
параметра следует указать центральную 
точку объекта. Текст будет выровнен по 
правому краю относительно этой точки. 

■ TL (ВЛ). Текст выравнивается по левой 
верхней точке. 
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Назначение параметров 
для выравнивания текста 

■ TC (ВЦ). Текст выравнивается по 
центральной верхней точке. 

■ TR (ВП). Текст выравнивается по правой 
верхней точке. 

■ ML (СЛ). Текст выравнивается по точке, в 
которой будет находиться середина 
прописных букв. При этом текст 
прижимается к левому краю. 
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Назначение параметров 
для выравнивания текста 

■ MC (СЦ). Текст выравнивается по точке, в 
которой будет находиться середина 
прописных букв. При этом текст 
центрируется по горизонтали. 

■ MR (СП). Текст выравнивается по точке, в 
которой будет находиться середина 
прописных букв. При этом текст 
прижимается к правому краю. 
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Назначение параметров 
для выравнивания текста 

■ BL (НЛ). Текст выравнивается по левой 
нижней точке. 

■ BC (НЦ). Текст выравнивается по 
центральной нижней точке. 

■ BR (НП). Текст выравнивается по правой 
нижней точке. 
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Многострочный текст

■ Преимущества использования команды 
MTEXT (Многострочный текст) видны в том 
случае, если необходимо создать большой 
блок текста, который должен содержать 
несколько строк и даже абзацев. 

■ Независимо от размера этого блока AutoCAD 
будет воспринимать его как единый объект. 
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■ После выполнения команды MTEXT 
(Многострочный текст) вы получите 
запрос: 

Specify first corner: (Укажите первый угол:)
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■ Многострочный текст помещается в 
прямоугольник, поэтому сначала программа 
предлагает выбрать один из углов этого 
прямоугольника. Сделав это, вы получите 
следующий запрос:

Specify opposite corner or [Height/Justify/Line 
spacing/Rotation/ Style/Width/Columns]: 
(Укажите противоположный угол или 
[Высота/Выравнивание/Междустрочный 

интервал/Поворот/Стиль/Ширина/Столбцы]:)
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■ Укажите угол, расположенный по диагонали от 
указанного вами ранее, чтобы программа могла 
сформировать прямоугольник для ввода текста. 

■ После этого будет открыт редактор 
многострочного текста. 
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Редактирование и 
форматирование текста

■ щелкните на текстовом объекте два раза; 
■ щелкните на текстовом объекте один раз, 

чтобы выделить его, после чего нажмите 
кнопку Edit (Правка) на панели 
инструментов Text (Текст); 
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Редактирование и 
форматирование текста

■ нажмите кнопку Edit (Правка) на панели 
инструментов Text (Текст), после чего 
выделите объект; 

■ выделите текстовый объект, щелкните на 
нем правой кнопкой мыши и выберите в 
открывшемся контекстном меню пункт Edit 
(Правка); 
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Редактирование и 
форматирование текста

■ щелкните на текстовом объекте один раз, 
чтобы выделить его, после чего 
выполните команду Modify > Object > Text 
> Edit (Редактирование > Объект > Текст 
> Правка); 

■ выполните команду Modify > Object > Text 
> Edit (Редактирование > Объект > Текст 
> Правка), после чего выделите объект. 
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Форматирование средствами 
редактора многострочного 
текста

■ Форматированием принято называть 
оформление текста, которое может 
включать в себя выделение посредством 
изменения размера, гарнитуры и 
начертания шрифта, выравнивание, 
изменение расстояния между буквами, 
создание списков разного типа.
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Установка параметров 
шрифта 

■ Форматировать текст можно как в 
процессе набора, так и после его 
выполнения. 

■ Помните, что если вы хотите 
форматировать набранный текст, то его 
обязательно нужно выделить.
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Действия по 
оформлению текста

■ Назначать стиль (Style) для оформления 
текста. 

■ Изменять гарнитуру шрифта (Font), по 
умолчанию используется шрифт txt. 
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Действия по 
оформлению текста

■ Создавать из текста аннотационный объект 
(Annotative). 

■ Выбирать высоту шрифта (Text Height). Вы можете 
задать высоту вручную или же выбрать значение из 
списка. 

■ Изменять начертание шрифта — делать его 
полужирным (Bold), курсивным (Italic), 
подчеркнутым (Underline), надчеркнутым (Overline). 
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Действия по 
оформлению текста

■ Отменять (Undo) и возвращать (Redo) действия. 
■ Вставлять дроби, а также верхние и нижние 

индексы (Stack). 
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Действия по 
оформлению текста

■ Отображать/скрывать линейку (Ruler). 
■ Задавать цвет шрифта (Color). 
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Действия по 
оформлению текста

■ Создавать текстовые                   
колонки (Columns). 

■ Устанавливать                  
вертикальное выравнивание: 
■ по верхнему краю (To p) — 

используется по 
умолчанию; 

■ по середине (Middle); 
■ по нижнему краю (Bottom). 
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Действия по 
оформлению текста

■ Настраивать параметры абзаца (Paragraph). 
■ Устанавливать горизонтальное выравнивание: 

■ по левому краю (Left) — используется по 
умолчанию; 

■ по центру (Center); 
■ по правому краю (Right); 
■ по ширине (Justify); 
■ равномерное распределение (Distribute). 

38



Создание списков и другие 
возможности форматирования 

■ буквенные ( Lettered) с символами в нижнем 
( Lowercase ) и верхнем ( Uppercase ) 
регистре; 

■ нумерованные ( Numbering); 
■ маркированные ( Bulleted); 

39



Меню создания списков

■ Restart (Заново) — позволяет начать список 
заново; 

■ Continue (Продолжить) — позволяет 
продолжить имеющийся список; 

■ Allow Auto-list (Разрешить автоматическое 
создание списков) — разрешает 
автоматическое форматирование текста в 
виде списка при вводе определенных 
символов; 
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Меню создания списков

■ Use Tab Delimiter Only (Использовать в 
качестве разделителя только символ 
табуляции) — позволяет автоматическое 
создание списков лишь при использовании 
символа табуляции; 

■ Allow Bullets and Lists (Разрешить 
использование списков) — позволяет 
работать со списками. 
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Возможности панели 
инструментов Text Formatting 
(Форматирование текста) 

■ Преобразование символов 
текста в набранные 
прописными ( UPPERCASE)        
и строчными ( lowercase ) 
буквами. 

■ Вставка специального символа   
( Symbol ). 

■ Установка угла наклона текста  
( Oblique Angle), расстояния 
между буквами ( Tracking) и 
ширины букв ( Width Factor ). 
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Колонки текста 

■ Эта функция позволяет разбить текст на 
несколько колонок. 

■ Для разбиения текста на колонки нажмите 
кнопку Columns (Колонки) и с помощью 
открывшегося меню укажите параметры 
разбиения. 
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Меню Columns (Колонки)
■ No Columns (Колонок нет) — разбиение на колонки 

отсутствует. 
■ Dynamic Columns                                                            

(Динамические колонки) —                                          
создание динамических колонок,                                                       
распределение текста в которых                          
происходит автоматически. 

■ Static Columns (Статические колонки) — создание 
статических колонок, для которых можно 
самостоятельно указать высоту, ширину и количество. 
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Меню Columns (Колонки)

■ Insert Column Break (Вставка разрыва 
между колонками) — позволяет вручную 
вставить разрыв между колонками. 

■ Column Settings (Настройки колонок) — 
вызывает диалоговое окно, рассмотренное 
выше. 
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Абзацы 

■ AutoCAD 2008                                     
предоставляет                                                 
гораздо более                                            
широкие                                                 
возможности                                            
форматирования абзацев. 

■ Для доступа к этим настройкам нажмите кнопку 
Paragraph (Абзац), и на экране появится 
одноименное окно, в котором вы можете 
указать различные параметры абзацев текста. 
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Окно Paragraph (Абзац)

■ Область Tab (Табуляция) служит для 
указания позиций табуляции. 

■ В области Left Indent (Отступ слева) с 
помощью полей First line (Первая строка) и 
Hanging (Поле) вы можете указать отступы 
для абзаца слева и для красной строки. 

■ Область Right Indent (Отступ справа) 
служит для указания поля абзаца справа. 
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Окно Paragraph (Абзац)
■ Установив флажок Paragraph Alignment 

(Выравнивание абзаца), вы можете указать тип 
выравнивания абзаца: по левому краю, по 
центру, по правому краю, по ширине или 
равномерное распределение. 

■ Установив флажок Paragraph Spacing (Расстояние 
между абзацами), вы можете определить 
расстояние между абзацами, указав в полях 
Before (До) и After (После) верхний и нижний 
отступы. 
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Окно Paragraph (Абзац)
■ Чтобы указать межстрочное расстояние, установите 

флажок Paragraph Line Spacing (Межстрочное 
расстояние абзаца). В списке Line Spacing 
(Межстрочное расстояние) выберите тип 
расстояния: 
■ Exactly (Точно) — точное значение расстояния; 
■ At least (Не менее) — минимальное значение 

расстояния; 
■ Multiple (Множитель) — число, на которое будет 

умножено межстрочное расстояние, заданное по 
умолчанию. 49



Настройка автоматического 
ввода дробей 

■ При вводе символов, 
которые программа 
распознает как возможные 
дроби, открывается окно 
AutoStack Properties 
(Свойства автоформата 
дробей). 

■ Оно дает возможность 
настроить автоматическое 
форматирование дробей при 
вводе. 
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■ Для того, чтобы программа выполняла 
преобразование корректно, нужно задать 
необходимые настройки в окне AutoStack 
Properties (Свойства автоформата дробей). 
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■ Для включения автоматического 
преобразования необходимо установить 
флажок Enable AutoStacking (Включить 
автоформат дробей). 

■ Затем можно установить флажок Remove 
leading blank: 1 x/y becomes 1x/y (Удалить 
пробел перед дробью: 1 x/y становится 
1x/y). 
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■ Переключатель Specify how "x/y" should 
stack (Укажите, как нужно представить 
дробь "x/y") позволяет выбрать один из 
двух вариантов преобразования: 

          - Convert it to a diagonal fraction 
(Преобразовать в дробь с косой чертой), 

          - Convert it to a horizontal fraction 
(Преобразовать в дробь с горизонтальной 
чертой). 53



■ Наконец, установка флажка Don't show this 
dialog again; always use these settings (Не 
показывать это окно снова; всегда 
использовать выбранные настройки) 
приведет к тому, что при следующем 
распознавании программой возможной 
дроби окно AutoStack Properties (Свойства 
автоформата дробей) вызвано не будет. 
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Вставка полей 
■ С помощью кнопки Insert 

Field (Вставить поле) 
можно получить доступ к 
окну Field (Поле), которое 
позволяет вставлять в 
текст обновляемые поля, 
такие как дата и время, 
название текущего 
чертежа, имя автора и т. д. 
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■ Чтобы быстро выбрать нужное поле для вставки, 
раскройте список Field category (Категория поля) 
и выберите категорию, например Date & Time 
(Дата и время). 

■ Укажите поле в списке Field names (Названия 
полей) и подберите необходимый формат. 

■ Это можно сделать с помощью списка Examples 
(Примеры). 

■ Для вставки поля в текст нажмите кнопку OK . 
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Работа с контекстным 
меню 

■ Контекстное меню редактора 
многострочного текста позволяет 
получать альтернативный доступ к 
командам, вынесенным на панель 
инструментов Text Formatting 
(Форматирование текста). 

■ Контекстное меню можно вызвать, 
щелкнув на поле ввода текста правой 
кнопкой мыши. 
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■ Контекстное меню содержит 
команды выделения всего 
текста ( Select All ), вырезания ( 
Cut ), копирования ( Copy ) и 
вставки(Paste), а также пункт 
Paste Special (Специальная 
вставка), который позволяет 
вставлять фрагменты текста 
без учета параметров 
форматирования абзацев и 
текста.. 
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Контекстное меню 
многострочного текста
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Команды для работы с 
редактором многострочного 
текста

■ Import Text                                           
(Импорт текста).                                     
Позволяет                                           
вставить в окно                                   
редактора                                          
содержимое                                               
любого                                                 
текстового файла в форматах TXT и RTF. 
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Команды для работы с 
редактором многострочного 
текста

■ Find and Replace (Найти и заменить). 
Вызывает окно поиска и замены текста 
(подробнее о нем рассказано ниже). 

■ Change Case (Изменить регистр). При 
выборе этого пункта открывается 
подменю, которое становится активным 
при выделении фрагмента текста. 
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Команды для работы с 
редактором многострочного 
текста

■ AutoCAPS (Автоматический Caps Lock ). 
Изменяет регистр букв так же, как это 
делает клавиша Caps Lock на клавиатуре. 

■ Character Set (Набор символов). Дает 
возможность выбрать требуемый набор 
символов из списка. 
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Команды для работы с 
редактором многострочного 
текста

■ Combine Paragraphs (Объединить 
абзацы). Данная команда становится 
активной, если выбран фрагмент 
текста. Она позволяет объединить 
несколько абзацев в один. 

■ Remove Formatting (Удалить 
форматирование). Данный пункт 
становится активным, если выбран 
фрагмент текста. Он позволяет 
отменить форматирование символов, 
такое как полужирное или курсивное 
начертание и пр. 
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Команды для работы с 
редактором многострочного 
текста

■ Background Mask (Маска фона). Позволяет 
установить цвет фона, на котором 
набирается текст. Параметры цвета фона 
задаются в одноименном окне. 
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Команды для работы с 
редактором многострочного 
текста

■ Editor Settings (Настройки редактора): 
■ Show Toolbar (Показать панель инструментов) — 

отображает/скрывает панель инструментов Text 
Formatting (Форматирование текста); 

■ Show Options (Показать параметры) — 
отображает/скрывает вторую строку панели Text 
Formatting (Форматирование текста); 

■ Show Ruler (Показать линейку); 
■ Text Highlight Color (Цвет выделения текста) — в 

открывающемся окне можно выбрать цвет 
выделения текста. 
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Команды для работы с 
редактором многострочного 
текста

■ Learn about MTEXT (Узнай о MTEXT). 
Открывает меню, с помощью которого вы 
можете получить доступ к разделу 
справки, посвященному появившимся в 
последней версии AutoCAD нововведениям 
по работе с многострочным текстом, или к 
окну справочной системы AutoCAD 2008, 
которое также может быть вызвано с 
помощью клавиши F1 . 

66



Поиск и замена текста 

■ Диалоговое окно Find and Replace (Найти 
и заменить) используется для поиска или 
же для поиска и одновременной замены 
символов. 
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Поиск
■ Откройте окно Find and Replace (Найти и 

заменить), вызвав его из контекстного меню или 
с помощью сочетания клавиш Ctrl+R . 

■ Введите числовые или текстовые символы, 
которые вы хотите найти, в поле Find what (Что). 

■ Установите флажок Match whole word only 
(Только слово целиком), если значение, 
введенное в поле поиска, должно полностью 
совпадать с искомым текстом. 
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Поиск

■ Установите флажок Match case (С учетом 
регистра), чтобы искать данные с учетом 
регистра (это касается текста). 

■ Нажмите кнопку Find Next (Найти далее). В 
этом случае программа найдет и выделит 
первый участок текста, который 
соответствует заданным параметрам 
поиска. 
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Замена

■ Она очень помогает, когда в тексте много 
одинаковых символов, которые нужно 
заменить. 

■ Например, работая над документом, вы 
ошиблись в написании термина, который 
встречается в нем не один раз. 

■ Замена помогает исправить подобные 
ошибки автоматически. 
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Замена
■ Откройте окно Find and Replace (Найти и 

заменить), вызвав его из контекстного меню или 
с помощью сочетания клавиш Ctrl+R . 

■ Введите числовые или текстовые символы, 
которые вы хотите найти, в поле Find what 
(Что). 

■ В поле Replace with (Чем) введите числовые или 
текстовые символы, которыми вы хотите 
заменить существующие данные. 
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Замена

■ Нажмите кнопку Find Next (Найти далее). 
Когда в документе будет выделен текст, 
который нужно заменить, нажмите кнопку 
Replace (Заменить).  

■ Если вы уверены, что заменить нужно все 
данные, соответствующие запросу, 
воспользуйтесь кнопкой Replace All 
(Заменить все). 
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Проверка правописания 
в документе

■ AutoCAD имеет встроенные средства 
проверки правописания, которые 
помогают исправить некоторые 
очевидные ошибки, например опечатки. 
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Проверка правописания 

■ выполните команду 
Tools Spelling (Сервис 
Орфография); 

■ воспользуйтесь 
командой SPELL 
(Орфо), введя ее в 
командную строку. 
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Область проверки
■ Entire drawing (Чертеж полностью) — проверка 

правописания по всему чертежу; 
■ Current space/layout (Текущее 

пространство/лист) — проверка в текущем 
пространстве модели или на листе; 

■ Selected objects (Выбранные объекты) — при 
указании этого пункта становится доступной 
кнопка выбора объектов, для которых требуется 
выполнить проверку орфографии. 
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Проверка правописания 

■ В области Not in dictionary (Отсутствует в 
словаре) отобразится слово, которое 
программа не смогла найти в 
подключаемом словаре. 

■ В списке Suggestions (Предположения) 
отобразятся похожие слова из словаря. 
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Проверка правописания 

■ Для замены выберите подходящее слово в 
этом списке и нажмите кнопку Change 
(Заменить). 

■ Для игнорирования ошибки и перехода к 
следующему слову нажмите кнопку Ignore 
(Игнорировать). 
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Проверка правописания 

■ Для добавления слова в словарь нажмите 
кнопку Add (Добавить). 

■ Для игнорирования всех таких же слов, 
встречающихся в тексте, нажмите кнопку 
Ignore All (Игнорировать все). 

■ Для замены слова выбранным нажмите 
кнопку Change All (Заменить все). 
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Проверка правописания 
■ Для выбора словаря, который будет 

использоваться для проверки, нажмите кнопку 
Dictionaries (Словари). 

■ В списке Current main dictionary (Текущий 
главный словарь) открывшегося окна Dictionaries 
(Словари) можно указать один из доступных 
словарей. 

■ Список Current custom dictionary (Текущий 
настраиваемый словарь) позволяет задать 
используемый настраиваемый словарь.
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Проверка правописания 
■ При выборе пункта Manage 

custom dictionaries (Управление 
настраиваемыми словарями) 
откроется окно, 
предназначенное для создания, 
добавления и удаления 
настраиваемых словарей. 

■ С помощью поля Content 
(Содержимое) можно добавлять 
слова в настраиваемый словарь, 
удалять введенные ранее и 
импортировать их из файла. 80



Текстовые стили
■ Стили представляют собой набор атрибутов 

форматирования, то есть могут включать 
гарнитуру, начертание, высоту шрифта и др. 

■ К выделенному фрагменту текста все атрибуты 
форматирования стиля применяются 
одновременно. 

■ Стили позволяют, задав один раз необходимые 
параметры, пользоваться ими все время, в 
разных документах.
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Создание и редактирование 
существующих стилей 

■ введите команду STYLE (Стиль) в 
командную строку; 

■ нажмите кнопку Text Style (Стиль 
текста) на панели инструментов 
Styles (Стили); 

■ нажмите кнопку Text Style (Стиль 
текста) на панели инструментов Text 
(Текст); 

■ выполните команду Format > Text 
Style (Формат > Стиль текста). 
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Создание и редактирование 
существующих стилей 

■ После этого откроется окно Text Style 
(Стиль текста), в поле Styles (Стили) 
которого отображается список с 
названиями всех доступных для 
редактирования стилей. 
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Создание и редактирование 
существующих стилей 

■ Для добавления нового стиля нажмите 
кнопку New (Создать) и в окне New Text 
Style (Создать стиль текста) введите 
название стиля, который автоматически 
становится текущим. 
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Создание и редактирование 
существующих стилей 

■ Чтобы удалить новый стиль, 
установите текущим один из 
имеющихся стилей, нажав 
кнопку Set Current 
(Установить текущим). 

■ После этого выделите стиль 
и нажмите кнопку Delete 
(Удалить). 
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■ Стиль может включать в себя параметры 
шрифта, а также дополнительные 
эффекты. 

■ В области Font (Шрифт) можно задать 
гарнитуру ( Font Name ) и начертание      
( Font Style) шрифта. 
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■ В области Size (Размер) можно указать, что 
данный стиль является аннотационным, 
установив флажок Annotative (Аннотационный). 

■ При щелчке на кнопке с буквой i откроется 
раздел справки, рассказывающий о 
масштабировании аннотационных объектов. 

■ Поле Height (Высота) служит для установки 
высоты текста. 
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■ В области Effects (Эффекты) 
устанавливаются флажки Upside down 
(Вверх ногами), Backwards (Задом 
наперед) и Vertical (Вертикально), а также 
задается ширина букв ( Width Factor ) и 
угол наклона текста ( Oblique Angle ). 
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■ Ниже поля                                                          
Styles (Стили)                                             
расположен                                        
раскрывающийся список, служащий для 
ограничения отображаемых в поле стилей. 

■ При выборе пункта Styles in use 
(Используемые стили) в поле будут 
отображаться лишь используемые стили. 
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■ После добавления стиля его название 
появится в списке Text Style Control 
(Управление стилем текста) на панели 
Text (Текст) пульта управления, а также в 
списке Style (Стиль) на панели Text 
Formatting (Форматирование текста) в 
редакторе многострочного текста. 
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Штриховка

■ Штриховкой называют заполнение 
трафаретом замкнутых областей рисунка. 

■ При заполнении пространства внутри 
объекта штриховка может изменяться в 
процессе его редактирования (например, 
изменения размеров). Такую штриховку 
принято называть ассоциативной. 
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Способы нанесения 
штриховки

■ Для нанесения штриховки в 
AutoCAD используется команда 
HATCH (Штрих). 

■ Некоторые заготовленные 
варианты штриховки доступны 
также на вкладке Hatches 
(Штрихи) инструментальной 
палитры. 
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Использование 
инструментальной палитры 

■ Чтобы настроить параметры 
штриховки на инструментальной 
палитре, щелкните на выбранном 
варианте штриховки правой 
кнопкой мыши и выберите в 
контекстном меню пункт Properties 
(Свойства). 

■ Откроется окно Tool Properties 
(Свойства инструмента), в 
котором можно выбрать угол 
наклона линий, масштаб, цвет и 
некоторые другие параметры 
штриховки. 93



■ Для нанесения штриховки посредством 
инструментальной палитры щелкните на 
выбранном варианте. После этого 
программа выдаст следующий запрос:

Specify insertion point: 
(Укажите точку вставки:) Щелкните на объекте вставки. 

■ Программа проанализирует его контуры и 
заполнит штриховкой замкнутую область.
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Использование команды 
HATCH (Штрих) 

■ введите команду 
HATCH (Штрих) в 
командную строку; 

■ нажмите кнопку Hatch 
(Штрих) на панели 
инструментов Draw 
(Рисование); 

■ выполните команду 
Draw > Hatch 
(Рисование > Штрих). 
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■ Список Type (Тип) предназначен для выбора 
типа штриховки: Predefined (Стандартный), User 
defined (Определенный пользователем) или 
Custom (Созданный ранее). 

■ В большинстве случаев устанавливается тип 
Predefined (Стандартный), поскольку в AutoCAD 
достаточно много заготовленных видов 
штриховок, из которых можно легко выбрать 
нужный. 
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■ Выбор штриховки 
осуществляется 
посредством списка 
Pattern (Узор). 
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Кнопки группы 
Boundaries (Границы)

■ Кнопка Add : Pick points (Добавить: выбрать 
точки) дает возможность указать точку внутри 
объекта, подлежащего штриховке, чтобы 
программа определила границы штриховки 
автоматически. После нажатия этой кнопки 
программа выдаст запрос: 

Pick internal point or [Select objects/remove Boundaries]: 
(Укажите точку или [Выберите объекты/удалите 

Границы]:)
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Кнопки группы 
Boundaries (Границы)

■ Кнопка Add : Select objects (Добавить: 
выбрать объекты) позволяет выбрать 
объекты для штриховки. 

■ Кнопка View Selections (Просмотреть 
выделения) помогает просмотреть все 
границы объектов, подлежащие 
штриховке. 
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Использование градиента 
для штриховки 

■ Вкладка Gradient 
(Градиент) диалогового 
окна Hatch and Gradient 
(Штрих и градиент) 
позволяет задать 
параметры градиентной 
заливки, которую можно 
использовать как 
штриховку для заполнения 
замкнутых областей. 
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Вкладка Gradient (Градиент) 
окна Hatch and Gradient (Штрих 
и градиент)

■ введите команду GRADIENT (Градиент) в 
командную строку; 

■ нажмите кнопку Gradient (Градиент) на 
панели инструментов Draw (Рисование); 

■ выполните команду Draw > Gradient 
(Рисование > Градиент). 
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■ Используя настройки, расположенные на 
вкладке Gradient (Градиент), можно 
выбрать тип градиента и определить его 
цвет. 

■ С помощью переключателей в области 
Color (Цвет) можно создать градиент на 
основе выбранного цвета ( One color ) или 
двух выбранных цветов ( Two color ). 
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■ Цвет выбирается с помощью окна Select 
Color (Выбор цвета), которое появляется 
при нажатии кнопки с многоточием в 
списке выбора цвета. 

■ В случае использования градиента One 
color (Один цвет) вы можете установить 
оттенок перехода с помощью ползунка. 
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■ Если переместить его в сторону Shade 
(Темный), то переход будет 
осуществляться к черному цвету, если же 
ползунок установлен ближе к Tint 
(Светлый) — к белому. 
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■ Установка флажка Centered 
(Центрировать) в области Orientation 
(Размещение) приведет к тому, что 
заливка будет размещена симметрично. 

■ В поле Angle (Угол) можно задать угол 
наклона образца. 
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■ Просмотреть, как будет выглядеть 
созданный образец, можно, нажав кнопку 
Preview (Предварительный просмотр). 

106



Редактирование 
штриховки

■ Для редактирования созданной ранее 
штриховки используется команда 
HATCHEDIT (Редштрих). 

■ В AutoCAD можно редактировать 
практически все параметры штриховки: 
масштаб, угол наклона линий, рисунок, 
границы и т. д. 
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Изменение штриховки

■ введите команду HATCHEDIT (Редштрих) в 
командную строку; 

■ выполните команду Modify > Object > 
Hatch (Редактирование > Объект > 
Штриховка). 
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■ После выполнения команды программа выдаст 
запрос:
Select hatch object: (Выберите штриховку:) Укажите 

объект со штриховкой, 
   после чего появится окно Hatch and Gradient 

(Штрих и градиент), только оно будет 
называться Hatch Edit (Правка штриховки), в 
котором вы сможете изменить параметры 
штриховки. 
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